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Executive summary

Citrix Systems, Inc. and Intel Corp. commissioned
Principled Technologies (PT) to measure power and
performance with Intel's vConsolidate version 2.0
(Profile 3) workload on quad-processor servers running
Citrix XenServer 5 using the following processors:

e Intel Xeon processor X7460
¢ Intel Xeon processor X7350

The servers were similarly configured with four
processors, 16 4GB DIMMs, and identical PCl-e NICs
and HBAs. Figure 1 shows the vConsolidate results for
both servers. It provides a comparison for the test

KEY FINDINGS

e The Intel Xeon processor X7460-based server
delivered 28.2 percent greater performance
running vConsolidate with eight CSUs than the
X7350-based server (see Figure 1).

e The Intel Xeon processor X7460-based server
produced 36.9 percent greater performance
per watt with eight CSUs than the X7350-
based server (see Figure 2).

servers with eight vConsolidate work units, consolidation

stack units (CSUs). (See the Workload section and later sections for more on CSUs.)

In this section, we discuss the best results for both servers. For complete details of the performance of each
server at its optimum number of CSUs, see the Test results section.

As Figure 1 illustrates, the Intel Xeon processor X7460-based server delivered 28.2 percent greater performance
running vConsolidate than the Intel Xeon processor X7350-based server.

As Figure 2 shows, the Intel Xeon processor X7460-based server produced 36.9 percent greater performance per

watt than the Intel Xeon processor X7350-based server.

Figure 2 normalizes the results to the lower-performing server, the Intel Xeon processor X7350-based server.

That system’s score is thus

vCon results

1.00. Normalizing makes
each data point in the chart a
comparative number, with

20.00

18.00 Intel Xeon
16,00 B e
14.00 - (8 CSUs)
12.00 -

10.00
8.00
6.00
4.00
2.00
0.00

Score

Server

higher numbers indicating
better performance per watt.

We calculated performance
per watt by dividing the
vConsolidate score for each
server by the measured
power when running eight
CSUs for a minimum 30-
minute interval. We
measured power at 208 V on
both servers.

Figure 1: vConsolidate results at eight CSUs for the two servers we tested.
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Figure 2: Relative vConsolidate performance/watt results at eight CSUs for the two
servers we tested.

close to 100 percent of the CPU capacity.

vConsolidate sums the throughput results of each type of work across all CSUs in a test. Then it amalgamates the
combined throughputs of all CSUs to create an overall score for the server under test. See the Test results
section for more information on this process.

vConsolidate uses the following four performance tests:

LoadSim

Microsoft Exchange Server 2003 Load Simulator (LoadSim) is a benchmark that measures a server’s
performance handling email. LoadSim uses the MAPI Messaging Benchmark 3 (MMB-3) to simulate MAPI email
clients. The simulated clients issue requests to an Exchange server to generate an email load. LoadSim
measures both the server’s response time and the number of messages it delivers. LoadSim is available for free
download from www.microsoft.com/downloads/details.aspx?Familyld=92EB2EDC-3433-47 CA-A5F 8-
0483C7DDEA85&displaylang=en.

SPECjbb2005

SPECjbb2005 is an industry-standard benchmark from the Standard Performance Evaluation Corp. (SPEC) that
measures a server’s Java performance. (Note: SPEC and SPECjbb2005 are trademarks of the Standard
Performance Evaluation Corporation.) SPEC modeled SPECjbb2005 on the three-tier client/server architecture,
with the middle layer as the primary focus. According to SPEC, “Random input selection represents the first (user)
tier. SPECjbb2005 fully implements the middle tier business logic. The third tier is represented by tables of
objects, implemented by Java Collections, rather than a separate database.” For more information about
SPECjbb2005, see www.spec.org/jbb2005/docs/UserGuide.html.

The results we quote here for this workload are not official SPECjbb2005 results because the vConsolidate
workload uses a slightly modified version of the benchmark. These results are not comparable to SPECjbb2005
results on SPEC’s Web site.

SysBench

The developers at SourceForge.net (www.sourceforge.net) created SysBench to test various aspects of the
performance of servers running database systems. The benchmark’s original target was the MySQL database
system (see www.mysql.com). Intel created a version of SysBench 0.4.0 that would work with Microsoft SQL
Server 2005 Enterprise Edition (www.microsoft.com/sql/editions/enterprise/default.mspx). We ran that version in
our test. In the vConsolidate workload, SysBench created a 100,000-row SQL database and executed a batch of
online transaction processing (OLTP) transactions against that data.

Principled Technologies, Inc.: vConsolidate performance and power on Intel-based 2
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WebBench

WebBench 5.0 (128-bit US version) is an industry-standard benchmark for Web server software and hardware. It
uses PC clients to send Web requests to the server under test. It generates performance results by incrementally
increasing the number of clients making HTTP 1.0 GET requests to the Web server; the result is a curve showing
the server’s performance under increasing load. The peak of that curve represents the peak throughput of the
server. WebBench reports both the total number of requests per second the server handled and the server’s total
throughput in bytes per second. To be certain that we found the true peak performance in our testing, we verified
that the server’s processor utilization reached or was extremely close to 100 percent during the test.

vConsolidate profiles
The vConsolidate workload comes with four sets of VM specifications, which it calls profiles. These profiles define
five key factors for each workload VM:
e number of virtual CPUs (vCPUs) the workload should receive
amount of virtual RAM (vMemory) the workload should receive
the operating system (OS) the workload should run
the key application the workload should run
the workload itself

As we noted earlier, vConsolidate refers to a single collection of these five virtual machines as a consolidate stack
unit (CSU). Depending on the type of server and its available resources, you may choose to run one or more
CSUs. The typical goal is to run enough CSUs to push the server under test to its maximum capacity by
consuming close to 100 percent of the CPU capacity. vConsolidate offers four profiles; we tested with Profile 3,
which we detail in Figure 3.

Profile 3
vCPUs vMemory 0S Application
WebBench (Web) 2 1.5GB Linux 32-bit Apache
LoadSim (mail) 1 1.5GB Windows 32-bit Exchange
SysBench (database) 2 1.5GB Linux 64-bit SQL Server
SPECjbb2005 (Java) 2 2.0GB Linux 64 bit BEA JVM
Idle 1 0.4 GB Windows 32-bit NA

Figure 3: The vConsolidate profile we used in our testing.

For further information on vConsolidate, please contact Intel.

Test results
The result for an execution of the vConsolidate workload amalgamates the results of all four of the workloads it
includes. To calculate a final score for a vConsolidate run, we used the following four steps, as vConsolidate
specifies:
1. Benchmark throughput = benchmark’s raw results/benchmark duration (for each of the four benchmarks)
2. Total benchmark throughput = add benchmark throughput for all CSUs in test
3. Normalized throughput = total benchmark throughput/reference system’s benchmark throughput
4. vConsolidate score = geomean (normalized throughput of all four benchmarks)

The first step in this process uses whatever raw results a benchmark produces, such as number of transactions or
operations, and the benchmark’s duration in seconds. We calculate a benchmark’s duration by subtracting the
start time of the vConsolidate test from its stop time and converting that time to seconds. WebBench is an
exception to this process because it automatically produces a score in requests per second. For this benchmark,
we calculate the average requests per second for the three WebBench mixes that run while the other benchmarks
are running and record this result as its throughput.
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The second step is to sum the throughput for a given benchmark across all CSUs. In the one-CSU case, there is
no need for this step. For the two- through eight-CSU tests, we summed the throughput of each individual
benchmark across all CSUs to obtain that benchmark’s final score.

The third step is to normalize the throughput. We use the one-CSU score of one of the systems under test as the
reference system and assign it a normalized score of 1.00. We then divide the summed throughput for a given
type of work by the reference score for that benchmark. This produces the normalized score for that type of work
in this test. In this test, we used as the reference score the one-CSU score on the Intel Xeon processor X7350-
based server. The last step is to take the geometric mean of the normalized throughput for all four benchmarks.

Figure 4 shows the final score (the median of three runs) and CPU uitilization of the test servers by number of
CSUs. The CPU utilization percentage is the average over the period the vConsolidate workload ran.

Server Intel Xeon processor X7350 Intel Xeon processor X7460
:fu(r:nsbttje; Score CPU Score CPU
1 4.26 26% 4.14 17%

2 8.04 54% 8.01 35%

3 11.27 85% 11.62 55%

4 13.11 98% 14.79 76%

5 14.02 100% 17.32 94%

6 14.52 100% 18.64 100%

7 15.04 100% 19.14 100%

8 15.34 100% 19.67 100%

Figure 4: vConsolidate results of the test servers with varying numbers of CSUs with corresponding CPU utilizations. Higher

scores are better.

Figure 5 details the power consumption, in watts, of the test servers while idle and during the median eight-CSU
test run.

Server Idle power (watts) Average power (watts)
Intel Xeon processor X7350 549.2 826.9
Intel Xeon processor X7460 546.2 773.2

Figure 5: Average power usage (in watts) of the test servers while idle and during the median eight-CSU test run. Lower
numbers are better.

Figure 6 shows the median eight-CSU test results, by benchmark and CSU, for the Intel Xeon processor X7350-

based server.

?;g;g_ebz;ggoscee:ir Java Database Mail Web Final score
CSU 1 10,642.43 246.75 16.15 351.83

CSuU 2 10,580.48 247.59 15.61 362.03

CsSuU 3 10,677.34 245.98 15.87 365.82

CSuU 4 10,644.48 248.31 15.66 358.46

CsSuU5 10,645.43 248.79 15.28 353.00

CsSu 6 10,536.20 248.34 15.74 368.28

CSu7 10,468.42 248.25 15.55 360.68

CSU 8 10,543.12 246.85 17.00 355.37 15.34

Figure 6: vConsolidate eight-CSU median results, by benchmark and CSU, for the Intel Xeon processor X7350-based server.
Higher scores are better.
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Figure 7 shows the median eight-CSU test results, by benchmark and CSU, for the Intel Xeon processor X7460-
based server.

?;Z:;i)(.eb:;:;oscee:se?r Java Database Mail Web Final score
CSuU 1 14,701.74 350.36 14.96 498.52

CSuU 2 14,590.94 350.64 16.15 498.15

CSU 3 14,732.32 349.35 15.22 499.83

CSuU 4 14,817.22 351.48 15.46 498.66

CSU 5 14,679.93 351.00 15.66 500.35

CSU 6 14,595.36 352.91 15.46 499.08

CsSu7 14,704.57 353.66 16.26 495.43

CSU 8 14,666.18 351.63 16.59 495.18 19.67

Figure 7: vConsolidate eight-CSU median results, by benchmark and CSU, for the Intel Xeon processor X7460-based server. Higher
scores are better.

We include complete results for all three runs on the two test systems in Appendix B.

Note: Due to the complexity and number of components the vConsolidate benchmark uses (e.g., network
interfaces, client computers, storage sub-system, configuration of VMs and benchmark components), Intel does
not recommend directly comparing test results from this report with results from other vConsolidate reports.
Unless the benchmark and its components have identical configurations, results may vary, providing an
inadequate basis for direct comparison.

Test methodology
Figure 8 summarizes some key aspects of the configurations of the two server systems; Appendix A provides
detailed configuration information.

Server Intel Xeon processor X7350-based Intel Xeon processor
server X7460-based server

Processor frequency (GHz) 2.93 2.66

Front-side bus frequency (MHz) 1,066 1,066

Number of processor packages 4 4

Number of cores per processor 4 6

package

Number of hardware threads per y 1

core

Motherboard S7000FC4UR S7000FC4UR

Chipset Intel ID3600 Intel ID3600

RAM (64GB in each) PC2-5300 FB-DDR2 PC2-5300 FB-DDR2

Figure 8: Summary of some key aspects of the server configurations.

Except for enabling Intel virtualization technology on both servers, we used the default BIOS settings.

To be sure we could push the processors of both of the system configurations to their maximum capacities, we
tested each server with as many vConsolidate CSUs as the server could handle, starting with one CSU, up to or
extremely close to 100 percent processor utilization. The rest of this section details how we set up the servers and
the vConsolidate workload.
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Hardware and software the test involved

Software
We used the following software to configure and run the vConsolidate workload:

Citrix XenServer 5 build 10918p

Microsoft Windows Server 2003 R2, Enterprise Edition
Linux 32-bit

Linux 64-bit

Apache

Microsoft Exchange Server 2003

Microsoft SQL Server 2005

BEA JRockit 1.6.0_02-b05

WebBench 5.0

Microsoft Exchange Server Load Simulator (LoadSim) 06.05.7775
SPECjbb2005 v1.07

SysBench v0.4.0

Intel vConsolidate 2.0

Hardware
Our test bed consisted of the following hardware:

The server under test

Eight custom-built Intel Desktop Board D915GMH with Intel Pentium 4 3.0GHz w/HT systems, which we
used for all WebBench clients, LoadSim clients, and WebBench controllers.

One custom-built Intel Server Board D945GTP system, which we used as both the main vConsolidate
controller

NETGEAR GS724T, which we set up into two VLANSs (one for external network and one for internal
network)

EMC CLARIiON CX3 storage

Three EMC CX-4PDAE-FD disk enclosures, with 15 x Hitachi HUS151473VLF4EO 73.4 GB disk drives
each

QLogic SANblade QLE2462 Dual Port 4-Gbps Fibre Channel Host Bus Adapter (HBA) installed in the
server under test

Figure 9 illustrates the test bed.

Principled Technologies, Inc.: vConsolidate performance and power on Intel-based
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s

vConsolidate test bed

CSU #n Combined |IP addresses

Internal network client Server under test
switch (WebBench « External network IP address: 192.168.0.250
\ controller,
WebBench client, | Main controller
and LoadSim « External network IP address: 192.168.0.100
client) « Internal network IP address for each CSU's
LoadSim and WebBench traffic: in form
( Internal network n 9 192.168.n1.100, where n is CSU number (e.g.,
@ CSU #1 =192.168.11.100)
—( External network \

% Internal network IP addresses
« Combined client: in form 192.168.n1.110, where n

is CSU # (e.g., CSU #1 = 192.168.11.110)

VM IP addresses
« Mail server VMs: in form 192.168.n1.115, where n
is CSU # (e.g., CSU #1 = 192.168.11.115)

Server under test

with one active NIC for Main controller

external network and one 3 « Web server VMs: in form 192.168.n1.215, where n
NIC per CSU for \ is CSU# (e.g., CSU #1 = 192.168.11.215)
WebBench and LoadSim % « JavaServer1 - n, DBServer1 - n, IdleServer1 —n
traffic (where n is highest CSU#) = DHCP

Figure 9: Our vConsolidate test bed.

Server installation

Installing
1. Insert the XenServer Version 5.0.0 disk into the server and reboot.
2. When the Select Keymap screen appears selected “[qwerty] us”, then tab to select OK, and press Enter.
3. At the Welcome to XenServer screen, select Install or upgrade XenServer Host, then tab to select OK,
and press Enter.
4. Atthe next screen make sure OK is selected, and Press Enter.
5. Atthe EULA screen, make sure Accept EULA is selected, and Press Enter.
6. At the Installation Type screen, select Perform clean installation, tab to select OK, and press Enter.
7. Atthe Select Primary Disk screen select the desired disk, tab to select OK, and press Enter.
8. Atthe Guest Storage screen, select the desired disk (in our case the same disk selected in the previous
step), then tab to select OK, and press Enter.
9. Atthe Select Installation Source screen select Local media (CD-ROM), tab to select OK, and press Enter.
10. At the Linux Pack screen, tab to Yes, and press Enter.
11. At the Verify Installation Source screen, select Skip Verification, tab to select OK, and press Enter.
12. At the Set Password screen type password in both the Password and the Confirm spaces, then tab to
select OK, and press Enter.
13. At the Network Interface screen, select the network interface you would like to use, tab to select OK, and
press Enter.
14. At the Networking screen, select Static Configuration, and press Enter. Enter the following information:
a. |IP Address: 192.168.0.250
b. Subnet Mask: 255.255.255.0
c. Gateway: 192.168.0.1
15. At the Hostname and DNS Configuration screen, enter the following information:

a. Hostname: xenserver-intel.vcon.com

Principled Technologies, Inc.: vConsolidate performance and power on Intel-based

servers running Citrix XenServer 5



16.
17.
18.
19.

20.
21.

22.
23.

b. DNS Server 1: 192.168.0.1
At the Select Time Zone screen, select the appropriate region, tab to select OK, and press Enter.
At the next Select Time Zone screen, select a city in your time zone, tab to select OK, and press Enter.
At the System Time screen, select manual time entry, tab to select OK, and press Enter.
At the Confirm installation screen, make sure Install XenServer is selected, then press Enter. Installation
may take several minutes.
When asked, insert the disk with Linux Pack, tab to select OK, and press Enter.
At the New Media screen, tab to select Use Media, and press Enter. Installation may take several
minutes.
At the Set local time screen, enter the appropriate information, tab to select OK, and press Enter.
At the Installation Complete screen, tab to select OK, and press Enter. The system will reboot.

Installing and configuring the mail server VM
Follow the steps below to create VMs using the following VM specifications:

e Name: MailServer1

Virtual processors: 1

Virtual memory: 1.5 GB

Virtual disk size: 10 GB

Virtual network: Internal Network (set the IP address to 192.168.11.115 in Windows within the VM)

Creating the virtual machine

11.
12.

13.

14.
15.
16.
17.
18.

19.
20.
21.
22.
23.

24.

Open XenCenter, and expand the server under test, if necessary.

Select VM, from the toolbar, and click New...

At the Select an operating system screen, select Windows Server 2003, (or desired operating system).
Click Next.

At the Enter a name screen, type mailserverl you are creating in the Name box. Click Next.

At the Enter the location screen, click the radio button next to ISO Image, and select the ISO image you
need. Click Next.

At the Set the number of CPUs screen, enter 1 as the number of vCPUs and 1536 as the amount of Initial
memory. Click Next.

At the Enter the information screen, select the only location displayed, and click Edit.

In the Disk Settings window, select INTEL_XEN_LUN1, and change the size of the virtual disk to 10.0,
then click OK.

Back at the Enter the information screen, click Add....

. In the Disk Settings window select INTEL_XEN_LUN1, and change the size of the virtual disk to 40.0,

then click OK.

Back at the Enter the information screen, click Next.

At the Add or remove virtual network interfaces, select the desired virtual network interface, and click
Next.

At the Your new virtual machine screen, make sure that Start VM automatically is selected, and then click
Finish.

At the top of the right panel, click the Console tab to view the Windows Server 2003 setup on the VM.
At the Welcome to Setup, press Enter.

At the Windows Licensing Agreement screen, press F8.

At the existing partitions screen, select the Unpartitioned space on the first drive, and press Enter.

At the next screen, select Format the partition using the NTFS file system, and press Enter. Formatting
and installation may take several minutes.

At the Regional and Language Options screen, click Next.

At the Personalize Your Software screen, type vCON in the name text box, and click Next.

At the Your Product Key window, enter the appropriate product key, and click Next.

At the Licensing Modes screen, select the radio button beside Per server, and enter 5 in the number of
concurrent connections box. Click Next.

At the Computer Name and Administrator Password screen, type the desired computer name, and the
password password. Click Next.

At the Windows Setup popup warning about password strength, click Yes.
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25.

26.
27.

28.

29.
30.

31.
32.
33.
34.
35.

36.
37.
38.
39.

40.
41.

At the Date and Time Settings screen, make the appropriate changes to reflect the correct time. Click
Next.

At the Networking Settings screen, select the radio button beside Typical settings, and then click Next.
At the Workgroup or Computer Domain screen, select the radio button beside No, and enter VCON as the
workgroup. Click Next.

At the Welcome to Windows screen, click the Ctrl+Alt+Del button at the bottom left of the right-hand
panel.

At the Log On popup window, enter the appropriate credentials, and click OK.

When the Windows Setup popup window appears, use the drop-down menu at the top of the right-hand
panel to select the appropriate ISO image. Click OK.

When the Windows Server 2003 R2 Setup Wizard popup window appears, click Next.

At the End-User License Agreement screen, click Next.

At the Setup Summary screen, click Next.

At the Completing Windows Server 2003 R2 Setup screen, click Finish.

At the Windows Server Post-Setup Security Updates popup window, click Configure automatic updating
for this server, then click Finish.

At the Windows Server Post-Setup Security Updates popup window, click Yes.

On the toolbar of XenCenter, click VM, and then click Install XenServer Tools.

At the Install XenServer Tools screen, click Install XenServer Tools.

At the Citrix Tools for Virtual Machines Setup screen, ensure that the check box beside “I accept the
terms of the License Agreement” is check, and click Next.

At the Choose Install Location screen, accept the default location by clicking Install.

At the Completing the Citrix Tools for the Virtual machines Setup Wizard, click the radio button beside
Reboot Now, and click Finish.

To finish setting up this VM for vConsolidate, we had to install several additional software components. The
following subsections detail the necessary installation processes.

Installing the domain controller

N>R~ ON =

9.

10.
11.
12.
13.

14.

15.
16.
17.
18.
19.

Select Start->Administrative Tools->Manage Your Server.

Click Add or remove a role.

At the Configure Your Server window, click Next.

At the Server Role screen, select Domain Controller, and click Next.

At the Summary of Selections screen, click Next.

At the Welcome pop-up window, click Next.

At the Operating System Compatibility screen, click Next.

For the Domain Controller Type, leave the default option (Domain controller for a new domain), and click
Next.

At the Create New Domain screen, leave the default (Domain in a new forest), and click Next.

At the Install or Configure DNS window, select No, and click Next.

At the New Domain Name screen, type a domain name (vcon. com), and click Next.

At the NetBIOS Domain Name screen, enter a NETBIOS domain name (vcon), and click Next.
Click Next through the following screens: Database and Log Folders, Shared System Volume, and
Permissions. Doing so accepts the default options for each of those screens.

At the Directory Services Restore Mode Administrative Password screen, enter a password (password),
and click Next.

When the installation software prompts you to do so, insert the OS CD, and click OK.

At the Completing the Active Directory Installation Wizard screen, click Finish.

When the system prompts you to reboot the VM, click Restart Now.

After the VM reboots, log in to the system.

At the This Server is Now a Domain Controller window, click Finish.

Installing Internet Information Services 6.0

1.
2.
3.

Select Start-> Control Panel=>Add or Remove Programs.
Click Add/Remove Windows Components.
Select Application Servers, and click Details.
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Click ASP.NET, and make sure a check appears in the box.

Select Internet Information Services (11S), and click Details.

Click NNTP Service and SMTP Service, make sure a check appears in both boxes, and click OK.
Click OK to close the Application Server window.

At the Windows Components Wizard, click Next to begin the installation.

When the system prompts you to do so, insert the OS CD, and click OK.

10 At the Completing the Windows Components Wizard window, click Finish.

11. Close the Add or Remove Programs window.

©Oe~ND O A

Installing Exchange Server 2003
1. Insert the Microsoft Exchange Server 2003 CD. The CD should automatically launch the installation
software.
2. Click Deploy the first Exchange 2003 Server.
3. Click New Exchange 2003 Installation.
4. Click Run ForestPrep now.
5. When the compatibility issue notice appears, click Continue, and check the Don’t display this message
again box.
At the Welcome screen, click Next.
Accept the End User License Agreement, and click Next.
At Component Selection Screen, keep the defaults, and click Next.
Leave the default account information, and click Next.
Installation should start. (This process may take a while to complete.)
10. When the installation completes, click Finish.
11. Return to the Exchange Server Deployment Tools screen, and click Run DomainPrep now.
12. At the Welcome screen, click Next.
13. Accept the End User License Agreement, and click Next.
14. At Component Selection Screen, keep the defaults, and click Next.
15. At the insecure domain notice, click OK.
16. When the installation completes, click Finish.
17. Return to the Exchange Server Deployment Tools screen, and click Run Setup Now.
18. At the Welcome screen, click Next.
19. Accept the End User License Agreement, and click Next.
20. At the Component Selection screen, the action for Microsoft Exchange should by default be Typical. (If it
is not, use the drop-down box to set it to Typical.)
21. Click Next.
22. For the Installation Type, select Create new Exchange Organization, and click Next.
23. Enter vcon as the Organization Name, and click Next.
24. Accept the Microsoft Exchange Server Licensing Agreement, and click Next.
25. Review the installation summary, and click Next.
The installation should start. (This process may take a while to complete.)
26. When the installation completes, click Finish.
27. Close the Exchange Server Deployment Tools window.
28. Install Microsoft Exchange Server 2003 Service Pack 2.
29. Insert the SP2 CD, and double-click update exe.
30. Accept the default location to extract the file, and click OK.
31. After the extraction finishes, open Windows Explorer, and browse to the update.exe executable.
32. At the Welcome screen, click Next.
33. Select | agree to accept the License Agreement, and click Next.
34. At the Component Selection window, leave the default option (Update), and click Next.
35. Verify the installation Summary, and click Next.
36. When the installation completes, click Finish.

Configuring the 40GB virtual hard disk
1. In the MailServer VM, right-click My Computer, and select Manage.
2. In the Computer Management Console, select Disk Management.
3. When a Welcome to Initialize and Convert Disk Wizard window appears, click Next.
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4. Select Disk 1 to initialize.

5. At the Select Disk to Convert screen, leave the disk unchecked.

6. Atthe Completing the Initialize and Convert Disk Wizard screen, click Finish.

7. Right-click the Disk 1 unallocated box, and select New Partition.

8. At the Welcome screen, click Next.

9. Leave the partition type as Primary, and click Next.

10. Accept the default Partition Size, which should be the same as the Maximum disk space, and click Next.
11. Assign the drive letter E, and click Next.

12. Format the partition with the NTFS File system, enter Mail Store for the volume label, and click Next.
13. At the Completing the New Partition Wizard screen, click Finish.

14. The partition should begin formatting.

15. When the formatting completes, close the Computer Management console.

16. Select Start>All Programs->Microsoft Exchange-> System Manager.

17. In the left window pane, expand Servers and MailServer so the First Storage Group is visible.
18. Right-click First Storage Group, and select Properties.

19. Click Browse, and change the Transaction log and System path location to E:\.

20. Check the Enable circular logging box, and click Apply.

21. When the pop-up message appears asking if you want to perform this task, click Yes.

22. When the message appears saying that all mounted stores are back online, click OK.

23. Right-click Mailbox Store under First Storage Group, and select Properties.

24. Select the Database tab.

25. Click Browse, and move the Exchange database and Exchange streaming database to E:\.
26. Check the This database can be overwritten by a restore box.

27. Click Customize next to Maintenance interval.

28. Remove all blue from the boxes so the system will not perform maintenance, and click OK.
29. At the Mailbox Store Properties window, click Apply.

30. When a warning message appears, click Yes.

31. When the message that the database files have been moved appears, click OK.

32. Click OK to close the Mailbox Store Properties window.

33. Right-click Public Store under First Storage Group, and select Properties.

34. Select the Database tab.

35. Click Browse, and move the Exchange database and Exchange streaming database to E:\.
36. Check the This database can be overwritten by a restore box.

37. Click Customize next to Maintenance interval.

38. Remove all blue from the boxes so the system will not perform maintenance, and click OK.
39. At the Public Store Properties window, click Apply.

40. When a warning message appears, click Yes.

41. When the message that the database files have been moved appears, click OK.

42. Click OK to close the Public Store Properties window.

43. Reboot the virtual machine.

Installing and configuring the web server VM

Create a VM using the following VM specifications:

Name: WebServer1 (use WebServer for the Host Name in the VM)

Virtual processors: 2

Virtual memory: 1.5 GB

Virtual Disk Size: 10GB

Virtual Network: Internal Network (set the IP address to 192.168.11.215 within the VM)

Creating the virtual machine
1. Open XenCenter, and expand the server under test, if necessary.
2. Select VM, from the toolbar, and click New...
3. Atthe Select an operating system screen, select Red Hat Enterprise Linux 5.2. Click Next.
4. Atthe Enter a name screen, type Webserverl in the Name box. Click Next.
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5. At the Enter the location screen, click the radio button next to ISO Image, and select the ISO image you
need. Click Next.
6. Atthe Set the number of CPUs screen, enter 2 as the number of vCPUs and 1536 as the amount of
Initial memory. Click Next.
7. At the Enter the information screen, select the only location displayed, and click Edit.
8. In the Disk Settings window select INTEL_XEN_LUN1, and change the size of the virtual disk to 10.0,
then click OK.
9. Back at the Enter the information screen, click Next.
10. At the Add or remove virtual network interfaces screen, select the desired virtual network interface, and
click Next.
11. At the Your new virtual machine screen, make sure that Start VM automatically is selected, and then click
Finish.
12. At the top of the right panel, click the Console tab to view the Red Hat Enterprise Linux 5.2 x64 setup on
the VM.
13. At the CD Found screen, tab to Skip, and press Enter.
14. At the Welcome screen, press Enter.
15. At the Language Selection screen, select English, tab to OK, and then press Enter.
16. At the Installation Number screen, select Skip entering Installation Number, tab to OK, and then press
Enter.
17. At the Skip screen, tab to Skip, then press Enter.
18. At the Warning screen, tab to Yes, then press Enter.
19. At the Partitioning Type screen, select Remove Linux partitions on selected drives and create default
layout. Also select /dev/xvda. Tab to OK, and press Enter.
20. At the Warning screen, tab to Yes, and click Enter.
21. At the Review partition Layout screen, tab to No, and press Enter.
22. At the Configure Network Interface screen, tab to Yes, and press Enter.
23. At the Network Configuration for ethO, select Activate on boot and Enable IPv4 support. Tab to OK, and
press Enter.
24. At the IPv4 Configuration for eth0, select and enter the following:
a. Manual address configuration
b. IP Address: 192.168.11.215
c. Prefix (Netmask): 255.255.255.0
Tab to OK, and press Enter.
25. At the Miscellaneous Network Setting screen, tab to OK, and press Enter. (This occurs twice.)
26. At the Error with Data screen, press Enter.
27. At the Hostname Configuration, select Manually, and enter webserver.vcon.com. Tab to OK, and
press Enter.
28. At the Time Zone Selection screen, select a city in your time zone. Tab to OK, and press Enter.
29. At the Root Password screen, enter password in both Password and Password (confirm). Tab to OK,
and press Enter.
30. At the Package selection screen, select Software Development and Web Server. Tab to OK, and press
Enter.
31. At the Installation to begin screen, press Enter. Installation may take several minutes.
32. At the Complete screen, use the drop-down menu at the top of the right-hand pane of XenCenter to select
<empty>. Click on the console again, and press Enter to reboot.
33. At the Setup Agent screen, select Firewall configuration, tab to Run Tool, and then press Enter.
34. At the Firewall Configuration screen disable the Security Level, as well as the SELinux. Tab to OK, and
then press Enter.
35. At the Setup Agent screen tab to Exit, then press Enter.
36. Log in with the following credentials, pressing Enter after each entry:
a. Login: root
b. Password: password
37. Type the following, pressing Enter after each entry:
a. chkconfig auditd off
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b. chkconfig smartd off
C. reboot
38. Log in as in step 53.
39. Select xs-tools.iso from the drop-down menu at the top of the right-hand panel of XenCenter.
40. Type the following, and press Enter after each entry:
a. mount /dcv/xvdd /mnt
b. /mnt/Linux/install.sh
C. vy
d. reboot
41. Log in as in step 53.

Configuring Apache
1. Open a terminal.
2. Type the following
nano -w /etc/httpd/conf/httpd.conf
press Crtl+W to search for LogLevel
Edit LogLevel from warn to crit
Add # infrontof CustomLog logs/access log common
Press Crtl+X.
Type Y and press Enter to save and close the editor.
nano -w /etc/httpd/conf.d/ssl.conf
Press Crtl+W to search for LogLevel
Edit LogLevel from warn to crit
Add # in front of TransferLog logs/ssl_access_log
Add # in front of CustomLog logs/ssl request log and in front of the line below it.
Press Crtl+X.
. Type Y and press Enter to save and close the editor.
Type the following commands:
i. chkconfig httpd on
ii. service httpd start
WebBench installation
1. Copy the WebBench files:
mkdir /mnt/ftpvol
mount 10.41.1.215:/ftpvol /mnt/ftpvol
cd /mnt/ftpvol/vcon2/
cp wbtree.tar.gz /var/www/html/
cd /var/www/html
tar -zxvf wbtree.tar.gz
cp wbtree/simcgi.c /var/cgi-bin/
cd /var/www/cgi-bin/
cc simcgi.c -o simcgi.exe

23T FTTI@T0Q00T0
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Installing and configuring the java application server VM

Create a VM using the following VM specifications:

Name: JavaServer1

Virtual processors: 2

Virtual memory: 2 GB

Virtual Disk Size: 10 GB

Virtual Network: External Network (set the IP address to 192.168.0.41 within the VM)

Creating the virtual machine
1. Open XenCenter, and expand the server under test, if necessary.
2. Select VM, from the toolbar, and click New...
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At the Select an operating system screen, select Red Hat Enterprise Linux 5.2 x64. Click Next.

4. Atthe Enter a name screen, type Javaserverl in the Name box. Click Next.
5. At the Enter the location screen, click the radio button next to ISO Image, and select the ISO image you
need. Click Next.
6. Atthe Set the number of CPUs screen, enter 2 as the number of vCPUs and 2048 as the amount of
Initial memory. Click Next.
7. Atthe Enter the information screen, select the only location displayed, and click Edit.
8. In the Disk Settings window select INTEL_XEN_LUN1, and change the size of the virtual disk to 10.0,
then click OK.
9. Back at the Enter the information screen, click Next.
10. At the Add or remove virtual network interfaces, select the desired virtual network interface, and click
Next.
11. At the Your new virtual machine screen, make sure that Start VM automatically is selected, and then click
Finish.
12. At the top of the right panel, click the Console tab to view the Red Hat Enterprise Linux 5.2 x64 setup on
the VM.
13. At the CD Found screen, tab to Skip, and press Enter.
14. At the Welcome screen, press Enter.
15. At the Language Selection screen, select English. Tab to OK, and then press Enter.
16. At the Installation Number screen, select Skip entering Installation Number. Tab to OK, and then press
Enter.
17. At the Skip screen, tab to Skip, then press Enter.
18. At the Warning screen, tab to Yes, then press Enter.
19. At the Partitioning Type screen, select Remove Linux partitions on selected drives and create default
layout. Also select /dev/xvda. Tab to OK, and press Enter.
20. At the Warning screen, tab to Yes, and press Enter.
21. At the Review partition Layout screen, tab to No, and press Enter.
22. At the Configure Network Interface screen, tab to Yes, and press Enter.
23. At the Network Configuration for ethO screen, select Activate on boot and Enable IPv4 support. Tab to
OK, and press Enter.
24. At the IPv4 Configuration for ethO screen, select and enter the following:
a. Manual address configuration
b. IP Address: 192.168.0.41
c. Prefix (Netmask): 255.255.255.0
25. Tab to OK and press Enter.
26. At the Miscellaneous Network Setting screen, enter 192.168.0. 1 as the Gateway, then tab to OK, and
press Enter.
27. At the Error with Data screen, press Enter.
28. At the Hostname Configuration screen, select manually, and enter javaserverl.vcon.com. Tab to OK
and press Enter.
29. At the Time Zone Selection screen, select a city in your time zone. Tab to select OK, and press Enter.
30. At the Root Password screen, enter password in both Password and Password (confirm). Tab to OK,
and press Enter.
31. At the Package selection screen, deselect all options, then tab to OK, and press Enter.
32. At the Installation to begin screen, press Enter. Installation may take several minutes.
33. At the Complete screen, use the drop-down menu at the top of the right-hand pane of XenCenter to select
<empty>, then click on the console again, and press Enter to reboot.
34. At the Setup Agent screen, select Firewall configuration, tab to Run Tool, and press Enter.
35. At the Firewall Configuration screen disable the Security Level, as well as the SELinux. Tab to OK, and
then press Enter.
36. At the Setup Agent screen tab to Exit, then press Enter.
37. Log in with the following credentials, pressing Enter after each entry:
a. Login: root
b. Password: password
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38. Type the following, pressing Enter after each entry:
a. chkconfig auditd off
b. chkconfig smartd off
C. reboot
39. Log in as in step 53.
40. Select xs-tools.iso from the drop down menu at the top of the right-hand panel of XenCenter.
41. Type the following, pressing Enter after each entry:
a. mount /dcv/xvdd /mnt
b. /mnt/Linux/install.sh
c. y
d. reboot
42. Login as in step 53.

To finish setting up this VM for vConsolidate, we had to install several additional software components. The
following subsections detail the necessary installation processes.

Installing SPECjbb2005
1. Copy the SPECjbb2005 files:
mkdir /mnt/ftpvol
mount 10.41.1.215:/ftpvol /mnt/ftpvol
cd /mnt/ftpvol/vcon2/
cp daemon /root/
cp jrockit-jdkl.6.0 03-linux x86 64.tar.gz /root/
cp -r vSpecJBB2005/ /root/
cd /root/
tar -zxvf jrockit-jdkl.6.0 03-linux x86 64.tar.gz
nano -w vSpecJBB2005/run.sh
Make sure that the jrockit path is jrockit-jdk1.6.0 03
Press Crtl+X.
Type Y and press Enter to save and close the editor.
. chmod +x vSpecdBB2005/run.sh
dos2unix vSpecJBB2005/run.sh
nano -w /etc/rc.local
Add the following to the end of the document:
i. /root/daemon > /root/daemon.log &
Press Crtl+X.
Type Y and press Enter to save and close the editor.

TOSIITXATTIoQ 00000
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Installing and configuring the database server VM

Create VM section using the following VM specifications.

Name: DatabaseServer1

Virtual processors: 2

Virtual memory: 1.5 GB

Virtual disk size: 10 GB

Virtual network: External Network (set the IP address to 192.168.0.21 within the VM)

Creating the virtual machine

Open XenCenter, and expand the server under test, if necessary.

Select VM, from the toolbar, and click New...

At the Select an operating system screen, select Red Hat Enterprise Linux 5.2 x64. Click Next.

At the Enter a name screen, type Databaseserverl in the Name box. Click Next.

At the Enter the location screen, click the radio button next to ISO Image, and select the ISO image you
need. Click Next.

arON=
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13.

14.

15.
16.
17.
18.

19.
20.
21.

22.
23.
24.
25.
26.

27.
28.
29.

30.
31.
32.
33.
34.

35.
36.

At the Set the number of CPUs screen, enter 2 as the number of vCPUs and 1536 as the amount of
Initial memory. Click Next.

At the Enter the information screen, select the only location displayed, and click Edit.

In the Disk Settings window, select INTEL_XEN_LUN1, and change the size of the virtual disk to 10.0,
then click OK.

Back at the Enter the information screen, click Add....

. In the Disk Settings window select INTEL_XEN_LUN1, and change the size of the virtual disk to 25.0,

then click OK.

. Back at the Enter the information screen, click Next.
. At the Add or remove virtual network interfaces, select the desired virtual network interface, and click

Next.
At the Your new virtual machine screen, make sure that Start VM automatically is selected, and then click
Finish.
At the top of the right panel, click the Console tab to view the Red Hat Enterprise Linux 5.2 x64 setup on
the VM.
At the CD Found screen, tab to Skip and press Enter.
At the Welcome screen, press Enter.
At the Language Selection screen, select English, tab to OK, and then press Enter.
At the Installation Number screen, select Skip entering Installation Number, tab to OK, and then press
Enter.
At the Skip screen, tab to Skip, then press Enter.
At the Warning screen, tab to Yes, then press Enter.
At the Partitioning Type screen, select Remove Linux partitions on selected drives and create default
layout. Also select /dev/xvda. Tab to OK, and press Enter.
At the Warning screen, tab to Yes and click Enter.
At the Review partition Layout screen, tab to Yes and press Enter.
At the partitioning screen, tab to New and press Enter.
At the New Partition or Logical Volume pop-up window, select partition, tab to OK, and press Enter.
At the Add Partition pop-up window, add and select the following information:
a. Mount Point: /home /mysqgl/logs
b. File System type: ext3
c. Allowable drives: xvdb
d. Size (MB): 5120
e. Fixed Size
f. Force to be a primary partition
Tab to OK, and press Enter.
At the partitioning screen, tab to New and press Enter.
At the New Partition or Logical Volume pop-up window, select partition, tab to OK, and press Enter.
At the Add Partition pop-up window, add and select the following information:
a. Mount Point: /home /mysqgl/logs
b. File System type: ext3
c. Allowable drives: xvdb
d. Size (MB): 1
e. Fill all available space
f. Force to be a primary partition
Tab to OK, and press Enter.
At the partitioning screen, tab to OK and press Enter.
At the Boot Loader Configuration screen, select Use GRUB Boot Loader. Tab to OK and press Enter.
In the available space type console=xvc0. Tab to OK and press Enter.
At the next Boot Loader Configuration screen, deselect all options. Tab to OK and press Enter.
At the next Boot Loader Configuration screen, select the only available device. Tab to OK and press
Enter.
At the next Boot Loader Configuration screen, select /dev/xvda. Tab to OK and press Enter.
At the Configure Network Interface screen, tab to Yes and press Enter.
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37.

38.

39.

40.
41.

42.
43.

44.
45.
46.

47.
48.

49.
50.

51.

52.
53.
54.

55.

At the Network Configuration for ethQ, select Activate on boot and Enable IPv4 support. Tab to OK and
press Enter.
At the IPv4 Configuration for ethO select and enter the following:
a. Manual address configuration
b. IP Address: 192.168.0.21
c. Prefix (Netmask): 255.255.255.0
Then tab to OK and press Enter.
At the Miscellaneous Network Setting screen, enter 192.168.0.1 as the Gateway. Tab to OK, and
press Enter.
At the Error with Data screen, press Enter.
At the Hostname Configuration, select manually and enter databaseserverl.vcon.com. Tab to OK,
and press Enter.
At the Time Zone Selection screen, select a city in your time zone, tab to select OK, and press Enter.
At the Root Password screen, enter password in both Password and Password (confirm). Tab to OK, and
press Enter.
At the Package selection screen deselect all options. Tab to OK, and press Enter.
At the Installation to begin screen press Enter. Installation may take several minutes.
At the Complete screen use the drop down menu at the top of the right-hand pane of XenCenter to select
<empty>, then click on the console again and press Enter to reboot.
At the Setup Agent screen select Firewall configuration and tab to Run Tool, then press Enter.
At the Firewall Configuration screen disable the Security Level, as well as the SELinux. Tab to OK then
press Enter.
At the Setup Agent screen, tab to Exit, then press Enter.
Log in with the following credentials, pressing Enter after each entry:
a. Login: root
b. Password: password
Type the following, pressing Enter after each entry:
a. chkconfig auditd off
b. chkconfig smartd off
C. reboot
Log in as in step 53.
Select xs-tools.iso from the drop down menu at the top of the right-hand panel of XenCenter.
Type the following, pressing Enter after each entry:
a. mount /dcv/xvdd /mnt
b. /mnt/Linux/install.sh
C. y
d. reboot
Log in as in step 53.

To finish setting up this VM for vConsolidate, we had to install several additional software components. The
following subsections detail the necessary installation processes.

Copy the SysBench files

® NGO WN =

9.
10.
11.

mkdir /mnt/ftpvol

mount 10.41.1.215:/ftpvol /mnt/ftpvol
cd /mnt/ftpvol/vcon2/

cp daemon /root/

cd sysbench/

cp sysbench /root/

cp start mysql.sh /root/

cp prepare sysbench.sh /root/

cp run.sh /root/

cd /mnt/ftpvol/rhel52/x86 64/Server/
rpm -ivh perl-DBI-*.x86 64.rpm
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12. cd /mnt/ftpvol/vcon2/mysqgl/

13. rpm -ivh MySQL-*.x86 64.rpm

14. service mysgl stop

15. chkconfig mysqgl off

16. cd /root

17. chmod +x *.sh

18. chmod +x sysbench

19. chmod +x daemon

20. mysgld --user=root --basedir=/usr --socket=/tmp/mysqgl.sock --skip-grant-
tables --default-table-type=INNODB --innodb data home dir=/home/mysqgl/data --
innodb log group home dir=/home/mysgl/logs --innodb log buffer size=64M --
innodb_additional mem pool size=32M --innodb_ flush log at trx commit=0 --
innodb log file size=1G --innodb thread concurrency=1000 --
max connections=1000 --table cache=4096 -innodb buffer pool size=1G --
innodb flush method=0 DIRECT &

21. mysgl -S /tmp/mysqgl.sock -e ”"drop database sbtest”

22. mysgl -S /tmp/mysqgl.sock -e ”create database sbtest”

23. ./sysbench prepare --test=oltp --mysgl-table-engine=innodb --oltp-table-
size=100000 --mysqgl-socket=/tmp/mysqgl.sock --mysgl-user=mysql

24. nano -w /etc/rc.local

25. Add the following to the end of the document:
/root/start mysgl.sh &
echo > /tmp/raw.log
cd /root/
./daemon > /root/daemon.log &

26. Press Crtl+X.

27. Type Y and press Enter to save and close the editor.

Backing up the database
1. mysgladmin -S /tmp/mysqgl.sock shutdown
2. mkdir /home/backup
3. cp -rv /home/mysql/* /home/backup/
4. rm -rvf /home/backup/*/lost+found/

Restoring the database
1. mysgladmin -S /tmp/mysql.sock shutdown
2. rm -rvf /home/mysqgl/data/ib*
3. rm -rvf /home/mysqgl/logs/ib*
4. cp -rvf /home/backup/* /home/mysqgl/

Installing and configuring the idle server VM

Create VM using the following specifications:

Name: IdleServer1

Virtual processors: 1

Virtual memory: 0.4 GB

Virtual disk size: 5 GB

Virtual network: External Network (set the IP address to 192.168.0.61 within the VM)

Creating the virtual machine
1. Open XenCenter, and expand the server under test, if necessary.
2. Select VM, from the toolbar, and click New...
3. At the Select an operating system screen, select Windows Server 2003, (or desired operating system).
Click Next.
4. Atthe Enter a name screen, type idleserverl you are creating in the Name box. Click Next.
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5. At the Enter the location screen, click the radio button next to ISO Image, and select the ISO image you
need. Click Next.

6. Atthe Set the number of CPUs screen, enter 1 as the number of vCPUs and 400 as the amount of Initial
memory. Click Next.

7. At the Enter the information screen, select the only location displayed, and click Edit.

8. Inthe Disk Settings window, select INTEL_XEN_LUN1, and change the size of the virtual disk to 5.0,
then click OK.

9. Back at the Enter the information screen, click Next.

10. At the Add or remove virtual network interfaces, select the desired virtual network interface, and click
Next.

11. At the Your new virtual machine screen, make sure that Start VM automatically is selected, and then click
Finish.

12. At the top of the right panel, click the Console tab to view the Windows Server 2003 setup on the VM.

13. At the Welcome to Setup, press Enter.

14. At the Windows Licensing Agreement, press F8.

15. At the existing partitions screen, select the Unpartitioned space, and press Enter.

16. At the next screen, select Format the partition using the NTFS file system, and press Enter. Formatting
and installation may take several minutes.

17. At the Regional and Language Options screen, click Next.

18. At the Personalize Your Software screen, type vCON in the name text box, and click Next.

19. At the Your Product Key window, enter the appropriate product key and click Next.

20. At the Licensing Modes screen, select the radio button beside Per server, and enter 5 in the number of
concurrent connections box. Click Next.

21. At the Computer Name and Administrator Password screen, type the desired computer name, and the
password password. Click Next.

22. At the Windows Setup popup warning about password strength click Yes.

23. At the Date and Time Settings screen, make the appropriate changes to reflect the correct time. Click
Next.

24. At the Networking Settings screen, select the radio button beside Typical settings and then click Next.

25. At the Workgroup or Computer Domain screen, select the radio button beside No, and enter vCON as the
workgroup. Click Next.

26. At the Welcome to Windows screen, click the Ctrl+Alt+Del button at the bottom left of the right-hand
panel.

27. At the Log On popup window, enter the appropriate credentials and click OK.

28. When the Windows Setup popup window appears, use the drop down menu at the top of the right-hand
panel to select the appropriate ISO image. Click OK.

29. When the Windows Server 2003 R2 Setup Wizard popup window appears, click Next.

30. At the End-User License Agreement screen, click Next.

31. At the Setup Summary screen, click Next.

32. At the Completing Windows Server 2003 R2 Setup screen, click Finish.

33. At the Windows Server Post-Setup Security Updates popup window, click Configure automatic updating
for this server, then click Finish.

34. At the Windows Server Post-Setup Security Updates popup window, click Yes.

35. On the toolbar of XenCenter, click VM, and then click Install XenServer Tools.

36. At the Install XenServer Tools screen, click Install XenServer Tools.

37. At the Citrix Tools for Virtual Machines Setup screen, ensure that the box beside “I accept the terms of
the License Agreement” is checked, and click Next.

38. At the Choose Install Location screen, accept the default location by clicking Install.

39. At the Completing the Citrix Tools for the Virtual machines Setup Wizard, click the radio button beside
Reboot Now, and click Finish.
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Client installation
In addition to setting up the server under test, we also had to set up the client systems we show in Figure 9. Both
the WebBench and LoadSim workloads require test clients.

Installing the WebBench 5.0 test client systems

To run WebBench, you need two types of test systems. WebBench clients use WebBench software engines to
send HTTP requests to stress the server under test. A single WebBench controller system manages the clients
during as the benchmark runs.

Installing a WebBench 5.0 client
1. Install Windows 2003 Enterprise Edition 32-bit. Use mailclient as the system name.
2. Install Windows Server 2003 Service Pack 2 with the default settings.
3. Open the Network Connections window by right-clicking My Network Places and selecting Properties from
the menu.
Right-click the network connection, and click Properties.
Highlight TCP/IP, and select Properties.
Select Use the following IP address, and enter the following information:
e |P address 192.168.12.211
e Subnet 255.255.255.0.
Click OK to close the two Properties windows.
Insert the WebBench CD, and open it with Windows Explorer.
Run setup.exe from the location /wb50/client/setup.exe.
. Click Next through all screens, a process that accepts the defaults.
. When the installation completes, copy the WebBench shortcut icon from the open window to the system’s
desktop.
12. Close the open windows, and eject the CD.
13. With WordPad, open the file c:\Windows\system32\drivers\etc\hosts.
14. After the last text in that file, enter the following additional lines, and click Save.
e 192.168.12.210 controller
(] 192.168.12.215 server
15. Close the hosts file and Windows Explorer.

ook
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Installing the WebBench 5.0 controller

We used a single system as both the WebBench 5.0 controller and the vConsolidate controller. We discuss the
specifics of the vConsolidate controller in a later section. We performed the following steps to set up that system
as the WebBench 5.0 controller:

Install Windows 2003 Enterprise Edition 32-bit. Use mailclient as the system name.
Install Windows Server 2003 Service Pack 2 with the default settings.

Insert the WebBench 5.0 CD.

Run /wb50/controlr/setup.exe

Click Next through the installation, which accepts all default options.

With Windows Explorer, open C: \WebBench\Controller\Clientids\client.cdb
Add the client’s IP address to the top of the file. Enter Tab twice, and type the number 1.
Click File>Save, and close the client.cdb file.

Copy vConsolidate.tst file from the vCON\WebBench directory to
C:\WebBench\controller\suites\WebBench.

. Copy the ecommerce cgi template w2k3.tst and ecommerce cgi template w2k3.wl files
from vCON\WebBench directory to C:\WebBench\controller\suites\WebBench
11. Copy all files from \vCON framework\WebBench daemon in the vConsolidate package to C:\.
12. Select Start->All Programs—>PC Magazine Benchmarks>WebBench 5.0 Controller.

13. Click Create/Edit from the Suites drop-down menu.

14. Browse to the vConsolidate. tst file, and click Open.
15. Highlight the first Mix, and click Edit.

16. On the General tab, change Engines per client to 8.

N> RALN =
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17.
18.
19.
20.
21.
22.

Select the Workload tab.

Change the number of threads to 1.

Click Copy across.

Select the Engines per client and Number of threads check boxes, and click OK.
Click OK to close the suites windows.

Close the WebBench Controller window.

Installing the mail test client
Each mail server VM requires one physical test client system. We performed the following steps to set up each
such system:

oAM=

7.
8.
9

10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.

Install Windows 2003 Enterprise Edition 32-bit. Use mailclient as the system name.

Install Windows Server 2003 Service Pack 2 with the default settings.

Open the Network Connections window by right-clicking My Network Places and selecting Properties.
Right-click the network connection, and click Properties.

Highlight TCP/IP, and select Properties.

Select Use the following IP address, and enter the following information: IP address 192.168.11.110,
Subnet 255.255.255.0, Preferred DNS server 192.168.11.115 (MailServer1 IP address).

Click OK to close the two Properties windows.

Right-click My Computer, and select Properties.

Click the Computer Name tab.

Click Change.

Select Domain in the member of section, and type the domain vcon . com into the text box.

In the pop-up window, enter administrator for user name, password for password, and click OK.

At the Welcome to the domain screen, click OK.

When the warning that you must restart dialog appears, click OK.

Click OK to close the System Properties window.

Click Yes to the pop-up message to restart the computer.

Log in to the domain using administrator and password.

Install Microsoft Outlook 2003 with the default settings. (Outlook 2003 doesn’t require any configuration.)
Install LoadSim 2003 by double-clicking the loadsim.msi installation file. Accept all defaults.

Open LoadSim 2003, and make sure no error messages appear.

Copy c:\Program Files\LoadSim\Islog.exe file to a floppy disk or USB thumb drive. You will need this file
during the vConsolidate controller installation.

Configuring LoadSim 2003

1. Start LoadSim by clicking Start Menu—->All Programs—>Exchange LoadSim->LoadSim 2003.
2. From the LoadSim menu bar, select Configuration->Topology Properties.
3. Click the Servers tab.
4. In the left pane, click the + beside the name of this server.
5. Inthe left pane, select the First Storage Group.
6. In the right pane, set the number of users to 500.
7. Select the Security and Credentials tab.
8. Leave the Credentials choice set to Log in to users using the account LoadSim is running on.
9. In the password portion of the tab, enter the password Password1, and click OK.
10. From the LoadSim menu bar, select Configuration—> Test Properties, and click Add.
11. Click Customize Tasks.
12. Select the Initialization tab.
13. Enter the following settings:
e Number of messages in Inbox: 150
e Number of messages in Deleted items: 1
e Number of new folders: 2
e Messages per new folder: 100
e Number of Smart Folders: 3
e Number of Rules in Inbox: 5
¢ Initialize Free/Busy Information: Leave it unselected
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14.
15.
16.
17.
18.

19.
20.

21.

22.
23.

e Number of appointments: 25

e Number of contacts: 64

Click OK.

In the Test Properties window, change the run time to 2 hours, and click OK.

From the LoadSim menu bar, choose File->Save As.

Save a backup copy of the simulation file as C:\loadsim.sim.

From the LoadSim menu bar, select Run—->Create Topology, and wait until the Creating Users and
Creating DLs tasks complete.

From the LoadSim menu bar, select Run—>Initialize Test.

When a dialog box appears with the question Do you want to initialize Public Folders from this client
machine? click Yes.

The run is complete when the bottom left corner of the LoadSim window shows Status: Idle. This task
typically takes about 2 to 3 hours to complete.

From the LoadSim menu bar, select Run—>Run Simulation.

The run is complete when the bottom left corner of the LoadSim window shows Status: Idle. This task
typically takes a little over 2 hours to complete.

Backing up the mail and database server files
For test consistency we made backup copies of the Mail and Database Server’s database files. Once you've set
up LoadSim and created its initial mail database, you need to back up that database so you can have clean

copies for each test. Do the same on the database server. We created a folder called backup on the E: drive of
each VM for the backup files. For testing we used scripts to perform a restore before each run so we started at

the same point for each run. An example of the scripts we used follows:

Restoring SysBench script
net stop mssglserver

sleep

1

del /F /Q "C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data\sbtest*"

sleep

1

copy /Y /V C:\sysbench backup\sbtest* "C:\Program Files\Microsoft SQL
Server\MSSQL.1\MSSQL\Data\"

sleep

1

net start mssqglserver

Restoring Exchange script
dismount .vbs

sleep

5

del /F /Q E:\publ.*
del /F /Q E:\privl.~*

copy /Y "E:\backup\publ.*" E:\
copy /Y "E:\backup\privli.*" E:\

mount

start
start
start
start
start
start

.vbs

/min net stop MSExchangeMGMT /yes
/min net stop RESvc /yes

/min net stop POP3Svc /yes

/min net stop IMAP4Svc /yes

/min net stop NntpSve /yes

/min net stop SMTPSVC /yes

net stop MSExchangeES /yes
net stop MSExchangeIS /yes
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net stop MSExchangeMTA /yes
net stop MSExchangeSA /yes

HTTPFilter (SSL).

start /min net stop IISADMIN /yes
start /min net stop MSSEARCH /yes
start /min net stop Spooler /yes

shutdown -r -f -t 15

vConsolidate controller

You use a separate physical system, the controller, to manage the vConsolidate workload. We used a single
section both for this function and as the controller system for the first CSU’s WebBench benchmark. This
controller offers a graphical user interface (GUI) to start and stop the vConsolidate workload. After the workload
finishes, the controller copies the independent benchmark result files from all the VMs and combines their results
into a single file, results.txt. We performed the following steps to set up this vConsolidate controller:

1. With Windows explore, create a C:\vCON directory.
2. Copy all files from the \WCON_framework\controller directory of the vConsolidate package to c:\\vCON.
3. Copy the Islog.exe file the mail client installation created to c:\vCON.

The vCON directory contains a Profiles sub-directory. The Profiles directory contains four sample profiles,
1CSU.profile, 2CSU.profile, 3CSU.profile, 4CSU.profile, and a blank template, Profile.template. vConsolidate
uses these files to identify the number and name of the VMs a test should include. An example 1CSU.profile
contains the following:

<Profile>

<Name>1 CSU</Name>

<CSUNum>1</CSUNum>

<Servers>

<DB>

<0S>Win</0S>

<Host>DBServerl</Host>

</DB>

<Loadsim>

<Host>192.168.202.110</Host>

</Loadsim>

<Java>

<0S>Win</0S>

<Host>JavaServerl</Host>

</Java>

<WebBenchs>

<Host>192.168.202.210</Host>

</WebBench>

</Servers>
</Profile>

Running vConsolidate

To run vConsolidate and get consistent results, you must first prepare the VMs with clean copies of the test data.
We outline below the process for getting ready to run the workload. We then explain how to start and stop the
workload. Finally, we detail how to find its results.

Preparing the vConsolidate run
Prior to running vConsolidate we restored the mail and database from backup files as we outlined in the section
Backing up the mail and database server files.

Verify connectivity and setting profiles
1. Open a command prompt by selecting Start->Run, type cmd, and click OK.
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Type the following commands at command prompt:

e net use \\loadsim client IP Address\c$

e net use \\JavaServerl\c$

e net use \\DBServerl\c$

e net use \\WebBench Controller IP Address\c$

Verify that the vConsolidate controller can read and write remote files to all VMs with the following
commands:

With Windows Explorer, create an empty file, dummy.txt.

copy dummy.txt \\loadsim client IP Address\c$

copy dummy.txt \\JavaServerl\cs$

copy dummy.txt \\DBServerl\c$

e. copy dummy.txt \\WebBench Controller IP Address\c$

Modify the profile file by entering the VM name or IP address appropriate to each VM in the test. For the
one-CSU test, enter four server names or IP addresses; for the two-CSU test, enter eight.

aoow

Startlng and stopping vConsolidate

oorwN

o N

21.

Shut down all VMs by selecting Start->Shutdown and then selecting Shutdown from the window.

In the left pane of the Virtual Infrastructure Client window, highlight localhost.localdomain.

Select the Summary tab in the right pane.

Click Reboot under the Commands section.

While the server is rebooting, reboot all clients in the test bed.

After the server under test has rebooted, log in using the Virtual Infrastructure Client, and start all VMs in
the test.

Once the VMs are up, log the LoadSim client(s) into the appropriate domain(s).

Double-click Daemon.exe manually on the following VMs and systems:

o DataServer1

e JavaServer1

e LoadSim client

e WebBench controller

Start the WebBench Controller application on the WebBench controller system by selecting Start->All
Programs—->PC Magazine Benchmarks.

. In the WebBench Controller application, choose the Clients menu, and click Start Log In.

. Double-click the WebBench 5.0 client shortcut on all the WebBench test client desktops.

. Once all the client machines are logged into WebBench, click OK.

. At the Would you like to add a test suite? dialog, click Yes.

. In the Select a test suite window, choose vConsolidate.tst, and click OK.

. When the Would you like to start executing the test suites? window appears, do NOT click Yes or No. The

vConsolidate controller application will handle that task that at the start of the test.

. Double-click c:\vCON\vconsolidate.exe.
. Select the profile name you want to run.
. Wait 15 minutes to allow all virtual machines and server under test to load all processes and become

completely idle.

. Click Start.
. The vConsolidate controller software will immediately start the LoadSim application. LoadSim will take

about 60 to 80 seconds to log 500 users onto the Exchange Server. The remaining benchmarks will start
once all the LoadSim users have logged in.

After about 30 minutes, the vConsolidate controller application will stop all the other benchmarks and
collect their results.

Locating and interpreting the results file
vConsolidate places all results data in the following location:

c:\vCON\vCONMM-dd-hh-mm

where MM is the month, dd is the day, hh is the hour, and mm is the minute of the test. The file result.txt in that
directory summarizes all the results. It contains the following information:
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Java transaction score
Database transaction score
Mail transaction score

Web server throughput
Start and stop times

Figure 10 shows an example results.txt file for a test with one CSU. We have labeled each score with a brief
description. See the Test results section for more information on how we used these individual results to calculate
each server’s overall score on the workload.

B result.txt
File Edit Format Wiew Help

uL =
JET sum=32354673 [ ava Score

DB Trans Number=231093— Database Score

—————————— TEMP. TXT
weighted avg 60 14015

—————————— VCONSOLIDATE. RLG

A,4_client, 8,]1706. 959, 6908069, 563, 0,
A,4_client, 8,/1622.183, 6576748, 875, 0,
A,d4_client, 8,[1558. 335, 6241389. 500, 0,
11:24:39.921
12:15:44,140

VWebBench Score

LoadSim Score

122 215 132 68 <--"score"

Figure 10: Example of vConsolidate results file.
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Power measurement procedure

To record each server’s power consumption during each test, we used an Extech Instruments (www.extech.com)
380803 Power Analyzer / Datalogger. We connected the power cord from the server under test to the Power
Analyzer’s output load power outlet. We then plugged the power cord from the Power Analyzer’s input voltage
connection into a power outlet.

We used the Power Analyzer’'s Data Acquisition Software (version 2.11) to capture all recordings. We installed the
software on a separate Intel-processor-based PC, which we connected to the Power Analyzer via an RS-232
cable. We captured power consumption at one-second intervals.

To gauge the idle power usage, we recorded the power usage while each server was running the operating
system but otherwise idle. To ensure the server was idle, we allowed the server to boot and power on all virtual
machines. Once the virtual machines had booted, we waited for 15 minutes to allow everything to stabilize. Then
we recorded two minutes of idle power (in watts) at one-second intervals.

To compute the average power usage, we averaged the power usage during the time the server was producing
its peak performance results. We call this time the power measurement interval. See Figure 5 (idle and average
peak power) for the results of these measurements.
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Appendix A — Test system configuration information

Figure 11 provides detailed configuration information about each of the test server systems, which we list in

alphabetical order by processor name.

Servers

Intel Xeon processor
X7350-based server

Intel Xeon processor
X7460-based server

General processor setup

Number of processor packages 4 4

Number of cores per processor package | 4 6

Number of hardware threads per core 1 1

System Power Management Policy Always on Always on
CPU

Vendor Intel Intel

Name Intel Xeon processor X7350 Intel Xeon processor X7460
Stepping B 1

Socket type Socket P (478) Socket P (478)
Core frequency (GHz) 2.93 2.66
Front-side bus frequency (MHz) 1,066 1,066

L1 cache

32 KB + 32 KB (per core)

32 KB + 32 KB (per core)

2 x4 MB (each 4 MBs shared

3 x 3 MB (each 3 MB

L2 cache by 2 cores) shared by 2 cores)
L3 cache N/A 16 MB
Platform
Vendor and model number Intel Fox Cove Intel Fox Cove
Motherboard model number S7000FC4UR S7000FC4UR
Motherboard chipset Intel ID3600 Intel ID3600
Motherboard revision number 01 01
Intel Intel
BIOS name and version SFC4UR.868.01.00.0024.061 | SFC4UR.868.01.00.0024.0
320082253 61320082253

BIOS settings

Enabled Intel Virtualization
Technology

Enabled Intel Virtualization
Technology

Memory module(s)

Vendor and model number Kingston Kingston
KVR667D2D4F5/4GlI KVR667D2D4F5/4Gl

Type PC2-5300 FB-DDR2 PC2-5300 FB-DDR2

Speed 667 MHz 667 MHz

Speed in the system currently running @ | 667 MHz 667 MHz

Timing/Latency (tCL-tRCD-iRP-

R ASrgnin) y( 5-5-5-15 5-5-5-15

RAM Module Size 4 GB 4 GB

Number of RAM modules 16 16

Chip organization Double-sided Double-sided

Total System Memory 64 GB 64 GB

Hard drive

Vendor and model number Seagate ST973401SS Seagate ST973401SS

Number of disks in system 2 2

Size 73.4 GB 73.4 GB

Buffer size 8 MB 8 MB
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Intel Xeon processor

Intel Xeon processor

SRS X7350-based server X7460-based server

RPM 10,000 10,000

Type SAS SAS

Controller Integrated Intel RAID Integrated Intel RAID
Controller SROMBSASFC Controller SROMBSASFC

Driver Megaraid_sas 00.00.03.20 Megaraid_sas 00.00.03.20

Operating system

Name Citrix XenServer 5 Citrix XenServer 5

Kernel release

2.6.18-
92.1.10.el5.xs5.0.0.394.644x
en

2.6.18-
92.1.10.el5.xs5.0.0.394.644
xen

Kernel version

#1 SMP Thu Aug 28 17:46:02
EDT 2008

#1 SMP Thu Aug 28
17:46:02 EDT 2008

File system ext3 ext3

Language English English

Graphics

Vendor and model number ATI ES1000 ATI ES1000

Chipset ES1000 ES1000

BIOS version BK-ATI VER008.005.031.000 | BXATI
VER008.005.031.000

Type Integrated Integrated

Memory size 32 MB 32 MB

Resolution 1,024 x 768 1,024 x 768

Network card/subsystem

Vendor and model number

Intel PRO/1000 EB

Intel PRO/1000 EB

Type

Integrated

Integrated

Driver version

1000 — 8.0.1-NAPI

1000 — 8.0.1-NAPI

Vendor and model number

Intel PRO/1000 PT

Intel PRO/1000 PT

Type PCle PCle
Driver version e1000 — 8.0.1-NAPI e1000 — 8.0.1-NAPI
Optical drive

Vendor and model number

Optiarc DVD-ROM DDU810A

Optiarc DVD-ROM

DDU810A
USB ports
Number 5 5
Type USB 2.0 USB 2.0
Power supplies
Total number 2 2
Wattage of each 1,570W 1,570W
Cooling fans
Total number 8 8
Dimensions 4x80mm+4x120 mm 4x80mm+4x120 mm
Voltage 12V 12V
Amps 4x1.76 A+4x3.3A 4x176 A+4x3.3A

Figure 11: Detailed system configuration information for the test servers.
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Appendix B — Complete test and power results

Figures 12 and 13 show the complete results for all three runs on the two test systems.

Intel Xeon processor X7350

| Score | CPU utilization | Idle power | Average power

1CSU

Run 1 4.26 26% 537.78 686.64

Run 2 4.29 26% 539.47 688.51

Run 3 4.23 26% 538.95 687.38
2 CSUs

Run 1 8.04 54% 540.41 767.45

Run 2 8.02 54% 542.32 767.99

Run 3 8.09 54% 540.03 766.83
3 CSUs

Run 1 11.22 85% 542.43 812.95

Run 2 11.27 85% 542.59 812.03

Run 3 11.34 85% 541.93 809.50
4 CSUs

Run 1 13.06 98% 545.56 825.45

Run 2 13.11 98% 543.30 821.68

Run 3 13.22 98% 543.42 821.88
5CSUs

Run 1 13.87 100% 547.61 827.14

Run 2 14.05 100% 545.55 823.76

Run 3 14.02 100% 543.83 824.63
6 CSUs

Run 1 14.52 100% 547.97 827.75

Run 2 14.59 100% 545.33 824.29

Run 3 14.44 100% 545.28 824.03
7 CSUs

Run 1 15.04 100% 549.35 826.87

Run 2 15.00 100% 548.08 824.24

Run 3 15.31 100% 538.98 831.61
8 CSUs

Run 1 14.99 100% 549.52 826.12

Run 2 15.45 100% 550.12 826.27

Run 3 15.34 100% 549.15 825.37

Figure 12: Complete results for all three runs on the Intel Xeon processor X7350 server.
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Intel Xeon processor X7460

Score | CPU utilization | Idle power | Average power

1CSU

Run 1 4.14 17% 541.43 642.97

Run 2 413 17% 539.33 640.90

Run 3 4.16 17% 539.63 640.54
2 CSUs

Run 1 7.98 35% 541.68 701.40

Run 2 8.01 35% 539.50 698.07

Run 3 8.08 35% 539.96 699.97
3 CSUs

Run 1 11.57 55% 542.56 735.34

Run 2 11.62 55% 542.12 735.17

Run 3 11.65 55% 542.21 734.85
4 CSUs

Run 1 14.66 75% 543.64 747.31

Run 2 14.89 76% 542.64 755.15

Run 3 14.79 76% 543.90 755.77
5 CSUs

Run 1 17.29 94% 543.09 765.85

Run 2 17.42 94% 543.75 768.49

Run 3 17.32 94% 542.68 767.23
6 CSUs

Run 1 18.69 97% 541.44 761.81

Run 2 18.64 99% 544.51 771.62

Run 3 18.46 99% 545.74 772.07
7 CSUs

Run 1 19.14 100% 544 .42 771.00

Run 2 18.95 100% 546.76 773.02

Run 3 19.15 100% 545.99 772.44
8 CSUs

Run 1 19.81 100% 546.40 771.00

Run 2 19.67 100% 546.22 773.21

Run 3 19.64 100% 546.93 772.58

Figure 13: Complete results for all three runs on the Intel Xeon processor X7460 server.
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